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Tutorial Outline 
Time (Tentative!) Module Topics Presenter 

8:00-8:30  1. Overview of Eclipse 
     and PTP, Installation check 

  Introduction to Eclipse/PTP; demo Greg 

 8:30-9:30 3. CDT: Working with C/C++ 
Remote Projects  

  Eclipse basics; Creating a new project 
  Building and launching remotely 

Beth 

9:30-10:00 4. Working with MPI   Makefiles, PLDT MPI tools 
  Resource Managers  
  Launching a parallel application 

Jay 

10:00-10:30 BREAK 

10:30-11:00 4. Working with MPI   Makefiles, PLDT MPI tools 
  Resource Managers  
  Launching a parallel application 

Jay 

11:00-12:00 5. Debugging   Debugging an MPI program Greg 

12:00 – 1:00 Lunch 

1:00-2:15 6. Fortran; Refactoring   Photran overview; comparison w/ CDT 
  Refactoring support 

Jeff 

2:15-2:30 BREAK 

2:30-4:30 7. Advanced Features: 
Performance Tuning & Analysis  
Tools 

  PLDT (MPI, OpenMP, UPC tools) (20 min)  
  TAU, ETFw (20) 
  GEM (20) 
  Linux Tools (gprof, gcov) (20 min) 
  Configuring Resource Managers (20 min) 

Beth 
Suzanne 
Alan 
Galen 
Jay 

4:30- 5:00 8. Other Tools, Wrapup   NCSA HPC Workbench,  Other Tools, website, mailing 
lists, future features 

Jay/Beth 



Final Slides, Installation 
Instructions 

 Please go to 
http://wiki.eclipse.org/PTP/
tutorials/TG11 for slides and 
installation instructions 



1-0 Module 1 

Module 1: Introduction 

 Objective 
 To introduce the Eclipse platform and PTP 

 Contents 
 What is Eclipse?  
 What is PTP? 
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What is Eclipse? 

 A vendor-neutral open-source workbench for 
multi-language development 

 A extensible platform for tool integration 
 Plug-in based framework to create, integrate 

and utilize software tools 



1-2 Module 1 

Eclipse Platform 

 Core frameworks and services with which all 
plug-in extensions are created 

 Represents the common facilities required by 
most tool builders: 
 Workbench user interface 
 Project model for resource management 
 Portable user interface libraries (SWT and JFace) 
 Automatic resource delta management for 

incremental compilers and builders 
 Language-independent debug infrastructure 
 Distributed multi-user versioned resource 

management (CVS supported in base install) 
 Dynamic update/install service 



1-3 Module 1 

Plug-ins 

  Java Development Tools (JDT) 
  Plug-in Development Environment (PDE) 
  C/C++ Development Tools (CDT) 
  Parallel Tools Platform (PTP) 
  Fortran Development Tools (Photran) 
  Test and Performance Tools Platform (TPTP) 
  Business Intelligence and Reporting Tools (BIRT) 
  Web Tools Platform (WTP) 
  Data Tools Platform (DTP) 
  Device Software Development Platform (DSDP) 
  Many more… 
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Launching & Monitoring 

Eclipse Parallel Tools Platform (PTP)   

Debugging 

Coding & Analysis 

Performance Tuning 

Module 1 
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Parallel Tools Platform (PTP) 

  The Parallel Tools Platform aims to provide a highly 
integrated environment specifically designed for parallel 
application development 

  Features include: 
  An integrated development environment (IDE) that 

supports a wide range of parallel architectures and runtime 
systems 

  A scalable parallel debugger 
  Parallel programming tools  

(MPI, OpenMP, UPC, etc.) 
  Support for the integration  

of parallel tools 
  An environment that simplifies the  

end-user interaction with parallel systems 
  http://www.eclipse.org/ptp 
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PTP Features Demo… 

  Creating a project from existing source code – 
importing into Eclipse and PTP 

  Content assist, searching, include browser 
  Building the project 
  Launching an MPI program 
  Debugging an MPI program 



Module 3: Working with C/C++ 
 Objective 

 Learn basic Eclipse concepts: Perspectives, Views, … 
 Learn how to use Eclipse to manage a remote project 
 Learn how to use Eclipse to develop C programs 
 Learn how to launch and run a remote C program 

 Contents 
 Brief introduction to the C/C++ Development Tools 

(CDT) 
 Create a simple remote application 
 Learn to launch a remote C application 

Module 3 3-0 
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Login Information 

 The hands on portion of this module will be 
done on a remote system at SDSC, thank you 
to SDSC! 
 Lincoln.ncsa.uiuc.edu 
 Train41-60 
 TG11tr8L! 

  See the following URL for more information on the 
system 
  http://www.sdsc.edu/us/resources/trestles/ 

 Each student will be assigned an ID and password 
at the start of the tutorial 

 Please use only this ID 
 We are also working to make this work with Ranger 

and Kraken, this work is not complete…  Module 3 



Eclipse Basics 
  A workbench contains the menus, toolbars, editors and 

views that make up the main Eclipse window 

perspective Module 3 

view 
view 

view 

editor 

  The workbench represents 
the desktop development 
environment 
  Contains a set of tools  

for resource mgmt 
  Provides a common way 

of navigating through  
the resources 

  Multiple workbenches  
can be opened at the 
same time 

  Only one workbench can 
be open on a workspace 
at a time 
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Perspectives 

 Perspectives define the layout of views and 
editors in the workbench 

 They are task oriented, i.e. they contain 
specific views for doing certain tasks: 
 There is a Resource Perspective for manipulating 

resources 
 C/C++ Perspective for manipulating compiled code  
 Debug Perspective for debugging applications 

  You can easily switch between perspectives 

 If you are on the Welcome screen now, select 
“Go to Workbench” now  

Module 3 3-3 



Switching Perspectives 

  Three ways of changing 
perspectives 

  Choose the Window>Open 
Perspective menu option 

  Then choose Other… 

  Click on the Open 
Perspective button in the 
upper right corner of screen 

  Click on a perspective 
shortcut button 

 Switch perspective 
on next slide… 
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Switch to Remote C/C++ Perspective 
  Select Window>Open 

Perspective 
  Then choose Other… 
  Only needed if you’re not 

already in the perspective 

  What Perspective am in in? 
   See title Bar 
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Views 

 The workbench window is  
divided up into Views 

 The main purpose of a view is: 
 To provide alternative ways of presenting information 
 For navigation 
 For editing and modifying information  

 Views can have their own menus and toolbars 
 Items available in menus and toolbars are  

available only in that view 
 Menu actions only  

apply to the view 

 Views can be resized 

view 

view view 
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Stacked Views 

 Stacked views appear as tabs 
 Selecting a tab brings that view to the 

foreground 
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Help 

  To access help 
  Help>Help Contents 
  Help>Search 
  Help>Dynamic Help 

  Help Contents provides 
detailed help on different 
Eclipse features in a 
browser 

  Search allows you to 
search for help locally, or 
using Google or the Eclipse 
web site 

  Dynamic Help shows help 
related to the current 
context (perspective, view, 
etc.) 
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Preferences 

  Eclipse Preferences allow 
customization of almost 
everything 

  To open use 
  Mac: Eclipse>Preferences… 
  Others: 

Window>Preferences… 

 The C/C++ preferences 
allow many options to be 
altered 

 In this example you can 
adjust what happens in the 
editor as you type. 
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Preferences (2) 

More C/C++ preferences: 
 In this example the 

Code Style preferences 
are shown 

 These allow code to be 
automatically  
formatted in different 
ways 

Module 2 3-10 
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Types of C/C++ Projects 
  C/C++ Projects can be 

  Local – source is located on local machine, builds happen locally 
  Remote – source is either located on remote machine, or 

synchronized with remote machine; builds take place on remote 
machine 

  Makefile-based – project contains its own makefile (or makefiles) 
for building the application 

  Managed– Eclipse manages the build process, no makefile 
required 

  Parallel programs can be run on the local machine or on a remote 
system 
  MPI needs to be installed 
  An application built locally probably can’t be run on a remote 

machine unless their architectures are the same 
  We will show you how to create, build and run the program on a 

remote machine 
  We will create a remote Makefile project 

-11 Module 3 



Remote Projects 

“Traditional” Remote Projects 
  Source is located on remote machine 
  Eclipse is installed on the local machine 

and can be used for: 
  Editing 
  Building 
  Running 
  Debugging 

  Source indexing is performed on remote 
machine 
  Enables call hierarchy, type 

hierarchy, include browser, search, 
outline view, and more… 

  Builds are performed on remote machine 
  Supports both managed and makefile 

projects 

  Application is run and debugged remotely 
using the PTP resource managers 

Synchronized Projects 
  Source is located on both the local system 

and on a remote target system.  The two 
copies are kept in sync by Eclipse. 

  Eclipse is installed on the local machine 
and can be used for: 
  Editing 
  Building 
  Running 
  Debugging 
  Development can continue “off-line” 

  Source indexing is performed on local 
machine 
  Enables call hierarchy, type 

hierarchy, include browser, search, 
outline view, and more… 

  Builds are performed on one or more 
remote machines 
  Supports both managed and makefile 

projects 
  Application is run and debugged remotely 

using the PTP resource managers 

3-12 Module 3 
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Traditional Remote Projects 



Preparation steps: 

  We will set up an SSH terminal to the remote system to 
copy some files 

  Make sure you are in the  
Remote C/C++ perspective 

  Select the Remote Systems view 
 Define a new connection 
 Select “SSH Only” 
 Then Next 

3-14 Module 3 



Preparation, continued 

  Add lincoln’s host info 
  Then Finish 

  Right click on ssh 
terminals, under lincoln 

  Select Launch Terminal 

3-15 Module 3 



Preparation, continued 

 Add your training 
account login 

 Click through any 
RSA messages 

 And now you have a 
terminal to lincoln 

3-16 Module 3 



Why did we do this? 

 To show you can gain “traditional” access to a 
remote host through Eclipse 

 And to have you stage some directories: 
 Issue the following commands in the terminal 

 cp –r ~jalameda/hello_world . 
 cp –r ~jalameda/shallow . 
 cp –r ~jalameda/mpi . 

 This will give us some source code to work 
with 
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  Use File>New>Remote C/C++ Project to open the 
new project wizard 

  The wizard will take you through the steps for creating 
the project 

Creating a Remote C/C++ Project 

Module 3 3-18 

Don’t see the “Remote C/C++ Project” choice? 
Make sure you are in the Remote C/C++ Perspective 



New Remote Project Wizard 

  Enter project name, e.g. “hello” 
  Select a Remote Provider 

  Remote providers supply different 
ways of accessing remote (or local) 
systems 

  Choose Remote Tools 

  A Connection specifies how to 
connect to the remote host 
  Click on the New… button to create a 

new connection 
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Remote Host Configuration 

  Enter a connection name (can be 
anything) for the Target name 
  Use “lincoln.ncsa.uiuc.edu” 

  The host is remote, so the Remote 
host option should be checked 

  Enter the host name or IP address of 
the remote host for the Host 
  Use “lincoln.ncsa.uiuc.edu” 

  Enter the user name and 
password supplied at the beginning of 
the tutorial for the User and 
Password 

  Note: if your remote machine uses OTP 
for authentication, leave the password 
field blank 

  Click Finish 
3-20 Module 3 



Project Location 

  The Location is the directory on 
the remote host containing the 
source and executable files 

  Click on the browse button to 
browse for folders on the remote 
machine 
  You should see the folders in your 

home directory 
  Choose the “hello” directory 

  Click OK 
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Project Type 
  The Project type determines 

information about the project 
  If the project is managed or 

unmanaged (described later) 
  The tool chain (compiler, linker, etc.) 

to use when building 
  If the project creates an executable, 

static, or shared library 
  Options available depend on whether 

the project is local or remote 
  Under Remote Makefile 

Project, select Empty Project  
  For Toolchains, select Other 

Toolchain 
  Click on Finish to complete the 

wizard 
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  If you need to change remote connection 
information (such as username or 
password), use the Remote 
Environments view  

Changing Remote Connection Information 
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  Stop the remote 
connection first 

  Right-click and 
select Edit 

  Note: running server is shown in lower right 
 Opening any remote file restarts it 



Project Explorer View 
  Shows the user’s projects 
  Each project contains 

  Source files 
  Executable files 
  Folders 
 Metadata (not visible) 

  Can have any number of projects 
  We only have a single project so 

far 
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New Project Wizard: 
Create a C Project 

  The New Project Wizard is used 
to create a C project 

  Enter Project name 
  Under Project Types, select 

Makefile projectEmpty 
Project 
  Ensures that CDT will use existing 

makefiles 

  Select Finish 
  When prompted to switch to the 

C/C++ Perspective, select Yes 
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Editor and Outline View 
  Double-click on 

source file to open 
editor 

  Outline view is 
shown for file in 
editor 

  You should see 
warnings on the 
include files: 
we will fix this 
later 

  Console shows 
results of build 
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Editors 

  An editor for a resource (e.g. a file)  
opens when you double-click on  
a resource 

  The type of editor depends on the type of the resource 
  .c files are opened with the C/C++ editor 
  Some editors do not just edit raw text 

  When an editor opens on a resource, it stays open across 
different perspectives 

  An active editor contains menus and toolbars specific to that 
editor 

  When you change a resource, an asterisk on the editor’s 
title bar indicates unsaved changes 

editor 
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  Save the changes by using Command/
Ctrl-S or File>Save 



Source Code Editors & Markers 

  A source code editor is a 
special type of editor for 
manipulating source 
code 

  Language features are 
highlighted 

  Marker bars for showing 
  Breakpoints 
  Errors/warnings 
  Task Tags, Bookmarks 

  Location bar for 
navigating to interesting 
features in the entire file 

Icons: 
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Line Numbers 

  Text editors can show line numbers in the 
left column 
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  To turn on line 
numbering: 
  Right-mouse click in 

the editor marker bar 
  Click on Show Line 

Numbers 



Include File Locations 

  Content assist and navigation 
requires knowledge of include file 
location on the remote system 

  The editor will indicate warnings 
on lines that have the problem 

  Problems View will display a 
warning 

  The project properties must be 
changed to resolve the problem 

3-30 Module 3 

Indexer: Unresolved inclusion: <stdio.h> in 
file: /u/ac/etrain1/hello/hello.c:11.  Please re-
configure project's remote include paths or 
symbols. 



  Open the project properties by 
right-clicking on project and 
select Properties 

  Expand Remote 
Development 

  Select Remote Paths and 
Symbols 

  Select GNU C to change  
C paths and symbols 

  Click Add 
  Enter “/usr/include” 
  Click OK 

Changing the Project Properties 
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  Click OK  to save the Project 
Properties 

  You will be prompted to 
rebuild the index 
  Select Yes 

  Red warnings should be  
gone from editor, since 
Eclipse knows the location  
of the include files now 

Saving  the Project Properties  
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  On demand hyperlink 
  Hold down Command/Ctrl key 
  Click on element to navigate to 

its definition in the header file 
(Exact key combination  
depends on your OS) 

  E.g. Command/Ctrl and click on 
EXIT_SUCCESS 

  Open declaration 
  Right-click and select Open 

Declaration will also open the 
file in which the element is 
declared 

  E.g. right-click on stdio.h and 
select Open Declaration 

Navigating to Other Files 
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Content Assist & Templates 
  Type an incomplete function name e.g. “get” into the editor, 

and hit ctrl-space  
  Select desired completion value with cursor or mouse 
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Hit ctrl-space again 
for code templates    Code Templates: type 

‘for’ and Ctrl-space 



  To manually build, select 
the project and press the 
the “build” button 

  Alternatively, select Project>Build 
Project 

  To rebuild if project is already built, 
Project > Clean… 

Building the Project 

  The project should build automatically when created  
  If there is no makefile, then the build will fail 
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After building the project: 
  The Console view shows build output 

  If the build is successful,  
the executable should appear  
in the project 

Building the Project (2) 
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Executable 



Build Problems 

  If there are problems, they 
will be shown in a variety 
of ways 
  Marker on editor line 
  Marker on overview ruler 
  Listed in the Problems view  

  Double-click on line in 
Problems view to go to 
location of error 
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Fix Build Problems 

  Save the file 
  Rebuild by pressing build 

button 
  Problems view is now 

empty 
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  Fix errors by giving getenv an argument and fixing 
declarations as shown 



Create a Resource Manager 

  A Resource Manager specifies how/where 
programs will be launched 

  Switch to the Parallel Runtime perspective 
  Window>Open Perspective… 

  In the Resource Managers view,  
right-click and select Add Resource 
Manager… 

  Select Remote Launch and Next > 
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Configure the Resource Manager 

  Choose Remote Tools for 
Remote service provider 

  Choose “lincoln.ncsa.uiuc.edu” 
for Connection name 
  This was the connection used 

when the project was created 

  Click Finish 
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  Right-click on the new 
resource manager and select 
Start Resource Manager 
from the menu 

  If the resource manager 
starts successfully, the icon 
should turn green 

  An icon color of red indicates 
a problem occurred 

Start the Resource Manager 
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NOTE: On some Linux systems, starting a resource 
manager may appear to hang. Open the window 
you launched Eclipse from and check if there is a 
prompt for a kerberos username. Hit “enter” twice 
if you see the prompt. 



To run the application, create a  
Run Configuration 

  Open the run configurations  
dialog 
  Click on the arrow next to the run button 
  Or use Run>Run Configurations… 

  Select Parallel Application 
  Select the New button  

Create a Run Configuration 

Depending on which flavor of 
Eclipse you installed, you might 
have more choices of application 
types 
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Complete the Resources Tab 

  Select your Resource Manager 
  Should be selected automatically if it has been started 

  The Remote Launch doesn’t require additional attributes 
  Other resource managers may have additional attributes, such as a 

queue name, etc. 
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Complete the Application Tab 

Module 3 3-44 

  Make sure “hello” is selected 
for the Parallel Project 

  Browse to find the 
executable file for the 
Application program 

  Launch the application by 
clicking the Run button 



Viewing Program Output 

  When the program runs, the Console view should 
automatically become active 

  Any output will be displayed in this view 
  Stdout is shown in black 
  Stderr is shown in red 
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Other CDT features 

 Searching 
 Mark Occurrences 
 Open Declaration / hyperlinking between files 

in the editor 
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First, return to the “Remote C/C++ 
Perspective” 



Language-Based Searching 

  “Knows” what things can 
be declared in each 
language (functions, 
variables, classes, 
modules, etc.) 

  For example, search for 
every call to a function 
whose name starts with 
“get” 

  Search can be project- or 
workspace-wide 
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Mark Occurrences 

 Double-click on a variable in the CDT editor 
 All occurrences in the source file are 

highlighted to make locating the variable 
easier 

 Alt-shift-O to turn off 
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Open Declaration 

  Jumps to the declaration of 
a variable, function, etc., 
even if it’s in a different file 

  Right-click on an identifier 
  Click Open Declaration 

  Can also Ctrl-click (Mac: 
Cmd-click) on an identifier 
to “hyperlink” to its 
declaration 
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Remote Projects - Location 

  How to tell where a project 
resides? 

  Right-click Project 
  Select Properties… 

  In Properties dialog, 
select Resource 
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Remote Projects - Reopening 

  When re-opening Eclipse 
workbench, remote projects 
will be closed 

  To re-open a closed project, 
Right-click on closed project 
and select Open Project 

  Open project shows folder 
icon, and can be expanded to 
show contents of project 
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4-0 

Module 4: Working with MPI 
 Objective 

 Learn how to develop, build and launch a parallel  
(MPI) program on a remote parallel machine 

 Contents 
 Remote project setup 
 Building with Makefiles 
 MPI assistance features   
 Working with resource managers 
 Launching a parallel application 

Module 4 4-0 
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Local vs. Remote 
  PTP allows the program to be run locally if you have MPI 

installed 
 However we want to run the program on a remote 

machine 
  We will now show you how to run a parallel program on 

a remote machine 
 Interactively 
 Through a batch system 
 Interactively through a batch system 

  We have provided the source code to an MPI program 
on the remote machine 

  The project will be created using this source code 
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Creating a Remote MPI Project 

  Like the previous module, create  
a new Remote C/C++ project 

  Enter “shallow” for the Project 
Name 

  Use the same Connection as before 
  Click the Browse… button and 

choose the directory “shallow” in  
in your home directory 

  Select a Remote Makefile Project 
as before 

  Click Finish 

4-2 Module 4 

You may be prompted to open  
the Remote C/C++ Perspective 



Changing the Project Build Properties 

  The project makefile has a non-standard name 
Makefile.mk 

  We need to change the build  
properties so that the project 
will build 
  By default, the project is built by 

running “make” 

  Right-click on project  
“shallow” in the Project  
Explorer 

  Select Properties 
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Changing the Build Command 

  Select C/C++ Build 
  Uncheck Use default build command 
  Change the Build command to: 

 make –f Makefile.mk 
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Building the Project 

  Click OK to save project properties after changing 
build command 

  Select project and hit the build button 
  The project can be built at any time  

by hitting this button 
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Include File Locations 

  Like the previous example, Eclipse content assist and 
navigation require knowledge of include file locations on the 
remote system 
  Since the build will be running remotely, the compiler knows 

how to find include files 
  But Eclipse does not 

  In Project Explorer,  
right-click on project 

  Select Properties 
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Include files on  
abe.ncsa.uiuc.edu 

Remote Paths and Symbols 

In Project Properties, 
  Expand Remote Development  
  Select 

Remote Paths and Symbols 
  Select Languages>GNU C 

  This is compiler on abe 

  Click Add… 
  Enter /usr/local/openmpi-1.4.2-intel-11.1/include 

  Click OK, then Add… again 
  Enter /usr/include 

  Click OK 
  Click OK to close preferences 
  When prompted to rebuild  

index, click OK 



MPI-Specific Features 

  PTP’s Parallel Language Development Tools (PLDT) 
has several features specifically for developing MPI 
code 
 Show MPI Artifacts 
 Code completion 
 Context Sensitive Help for MPI 
 Hover Help 
 MPI Templates in the editor 
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More MPI features covered in  
Module 7: Advanced Features 
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Show MPI Artifacts 

Module 4 4-9 

  In Project Explorer, select a project, folder, or a single source file 
  The analysis will be run on the selected resources 

  Run the analysis by clicking on drop-down menu next to the 
analysis button  

  Selecting Show MPI Artifacts 
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MPI Artifact View 

  Markers indicate the 
location of artifacts in 
editor 

  The MPI Artifact View 
list the type and location 
of each artifact 

  Navigate to source code 
line by double-clicking on 
the artifact 

  Run the analysis on 
another file (or entire 
project!) and its markers 
will be added to the view 

  Remove markers via 
  Click on column headings 

to sort  
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MPI Editor Features 
  Code completion will show all 

the possible MPI keyword 
completions 

  Enter the start of a keyword 
then press <ctrl-space> 
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  Hover over MPI API 
  Displays the function 

prototype and a 
description 
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Context Sensitive Help 
  Click mouse, then press help 

key when the cursor is within a 
function name 
  Windows: F1 key 
  Linux: ctrl-F1 key 
  MacOS X: Help key or 

HelpDynamic Help 
  A help view appears (Related 

Topics) which shows 
additional information 
(You may need to click on MPI 
API in editor again, to 
populate) 

  Click on the function name to 
see more information 

  Move the help view within your 
Eclipse workbench, if you like, 
by dragging its title tab 
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Some special 
info has been 
added for MPI 

APIs 
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MPI Templates 

 Example:  
    MPI send-receive 

 Enter:  
   mpisr <ctrl-space> 

 Expands to a send-receive 
pattern 

 Highlighted variable names 
can all be changed at once 

 Type mpi <ctrl-space> <ctrl-
space> to see all templates 

Add more templates using Eclipse preferences! 
C/C++>Editor>Templates 

Extend to other common patterns 
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 Allows quick entry of common patterns in MPI programming 



4-14 

Running the Program 
 Creating a resource manager 
 Starting the resource manager 
 Creating a launch configuration 
 Launching the application 
 Viewing the application run 
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Terminology 

  The Parallel Runtime perspective is provided for 
monitoring and controlling applications 

  Some terminology 
 Resource manager - Corresponds to an instance of 

a resource management system (e.g. a job 
scheduler). You can have multiple resource 
managers connected to different machines. 

 Queue - A queue of pending jobs 
 Job – A single run of a parallel application 
 Machine - A parallel computer system 
 Node - Some form of computational resource 
 Process - An execution unit (may be multiple 

threads of execution) 
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Resource Managers 

  PTP uses the term “resource manager” to refer to any 
subsystem that controls the resources required for launching a 
parallel job.  

  Examples:  
 Job scheduler (e.g. LoadLeveler, PBS, SLURM) 
  Interactive execution (e.g. Open MPI, MPICH2, etc.) 

  Each resource manager controls one target system 
  Resource Managers can be local or remote 
  Note: PTP 5.0 is in transition with respect to resource managers 

and status monitoring;  
  PBS (“jaxb lml” ) is new-style resource manager, with System Monitor 

runtime 
  All others are old-style resource managers, using Parallel Runtime 
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Preparing to Launch 
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  Setting up a resource manager is done in the Parallel 
Runtime perspective 

  Select Window>Open Perspective>Other 
  Choose Parallel Runtime and click OK 
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Parallel Runtime Perspective 

Resource 
managers 
view 

Machines 
view 

Node details    
view 

Jobs List view 
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Console 
view 

Properties 
view 
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About PTP Icons 

  Open using legend icon in 
toolbar 
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Running Jobs Interactively 

  Interactive resource 
managers will run the 
parallel application 
immediately 

  They are also used for 
debugging the application 

  Right-click in Resource 
Managers view and select 
Add Resource Manager 

  Choose the Open MPI 
Resource Manager Type 

  Select Next> 
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Configure the Remote Location 
  Choose Remote Tools for 

Remote service provider 
  Choose the remote 

connection you made 
previously 

  Click Next> 
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Configure the Resource Manager 
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  The Open MPI resource 
manager will auto detect the 
version and use the 
appropriate commands 
  Change only if you’re an 

expert 
  Set the location of the 

“mpirun” command if it is not 
in your path 

  Click Next> 
  Change the Name or 

Description of the resource 
manager if you wish 

  You can also set the resource 
manager to automatically 
start 

  Click Finish 
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Starting the Resource Manager 

  Right click on new 
resource manager and 
select Start resource 
manager 

  If everything is ok, you 
should see the resource 
manager change to green 

  If something goes wrong, 
it will change to red 
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System Monitoring 

  Machine status shown 
in Machines view 

  Node status also 
shown Machines view 

  Hover over node to see 
node name 

  Double-click on node to 
show attributes 
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  Open the run configuration  
dialog Run>Run 
Configurations… 

  Select Parallel Application 
  Select the New button  

Create a Launch Configuration 

Depending on which flavor of Eclipse you 
installed, you might have more choices in 

Application types 
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Complete the Resources Tab 

Module 4 4-26 

  Enter a name for the 
launch configuration, 
e.g. “shallow” 

  In Resources tab, 
select the resource 
manager you want to 
use to launch this job 

  Enter a value  
in the Number of 
processes field 

  Other fields can be used 
to specify resource 
manager-specific 
information 
 E.g. specify  

By node to allocate 
each process to a 
different node 
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Complete the Application Tab 

  Select the Application 
tab 

  Choose the Application 
program by clicking 
the Browse button and 
locating the executable 
on the remote machine 
  There should be a 

“shallow” executable in 
the “shallow” directory  

  Select Display output 
from all processes in 
a console view 

  Click Run to run the 
application 
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Viewing The Run 

  Double-click a 
node in machines 
view to see which 
processes ran on 
the node 

  Hover over a 
process for tooltip 
popup 

  Job status and 
information 
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Viewing Program Output 

  Console displays 
combined output 
from all processes 

  Properties view 
shows job details 
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Using a Job Scheduler 

Module 4 4-30 

  Setting up a resource manager is done in the System 
Monitoring perspective 
  (For PTP 5.0.0, this applies to PBS) 

  Select Window>Open Perspective>Other 
  Choose System Monitoring and click OK 



System Monitoring Perspective 
  System view 

  Jobs running 
on system 

  Active jobs 

  Inactive jobs  
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Using a Job Scheduler 

  Right-click in Resource 
Managers view and 
select Add Resource 
Manager 

  Choose the PBS-
Generic-Batch 
Resource Manager 
Type 

  Select Next> 
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Configure the Remote Location 
  Choose Remote Tools for 

Remote service provider 
  Choose the remote 

connection you made 
previously 

  Click Next> 
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Configure the Monitor 
Connection 
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  Keep default Monitor 
Connection (same as Control 
Connection), click Next 



4-35 

Configure the Common Resource 
Manager Parameters 

Module 4 4-35 

  Keep default name 
  Can automatically start 

Resource Manager (leave 
unselected today) 

  Click Finish 



4-36 

Starting the Resource Manager 

  Right click on new 
resource manager and 
select Start resource 
manager 

  If everything is ok,  
you should see the 
resource manager 
change to green 

  If something goes 
wrong, it will change  
to red 
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System Monitoring 

  System view, with 
abstraction of nodes 

  Active and inactive 
jobs 

  Hover over node to see 
job running on node 
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  Open the run configuration  
dialog Run>Run 
Configurations… 

  Select Parallel Application 
  Select the New  

button  

Create a Launch Configuration 
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Complete the Resources Tab 

  Enter a name for this 
launch configuration, e.g. 
“shallow-pbs-batch 

  Choose the appropriate 
Resource Manager (PBS-
Generic-Batch) 

  In Resources tab, select 
the PBS resource manager 
you just created 

  The MPI Command field 
allows this job to be run 
as an MPI job 
  Choose mpirun 

  Enter the resources 
needed to run this job 
  Use 1 nodes, 4 gb memory, 4 

cores 

  Select the destination 
queue – lincoln_debug 
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Complete the Application Tab 

  Select the Application 
tab 

  Choose the Application 
program by clicking the 
Browse button and 
locating the executable on 
the remote machine  
  Use the same “shallow” 

executable 
  Select Display output 

from all processes in a 
console view 

  If Debugger tab has error, 
select Debugger: SDM 

  Click Run to submit the 
application to the job 
scheduler 
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Job Monitoring 

  Job initially 
appears in 
“Inactive Jobs”, 
then in “Active 
Jobs”, then 
returns to 
Inactive on 
completion 

  Can view output 
or error by right 
clicking on job, 
selecting 
appropriate 
output 
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Interactive Job Scheduler 

  Right-click in Resource 
Managers view and 
select Add Resource 
Manager 

  Choose the PBS-
Generic-Interactive 
Resource Manager 
Type 

  Select Next> 
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Configure the Remote Location 
  Choose Remote Tools for 

Remote service provider 
  Choose the remote 

connection you made 
previously 

  Click Next> 
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Configure the Monitor 
Connection 
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  Keep default Monitor 
Connection (same as Control 
Connection), click Next 
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Configure the Common Resource 
Manager Parameters 
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  Keep default name 
  Can automatically start 

Resource Manager (leave 
unselected today) 

  Click Finish 
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Starting the Resource Manager 

  Right click on new 
resource manager and 
select Start resource 
manager 

  If everything is ok,  
you should see the 
resource manager 
change to green 

  If something goes 
wrong, it will change  
to red 
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  Open the run configuration  
dialog Run>Run 
Configurations… 

  Select Parallel Application 
  Select the New  

button  

Create a Launch Configuration 
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Complete the Resources Tab 

  Enter a name for this 
launch configuration, e.g. 
“shallow-pbs-interactive 

  In Resources tab, select 
the PBS resource manager 
you just created 

  The MPI Command field 
allows this job to be run 
as an MPI job 
  Choose mpirun 

  Enter the resources 
needed to run this job 
  Use  4 gb memory, 4 cores 

  Select the destination 
queue – lincoln_debug 
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Complete the Application Tab 

  Select the Application 
tab 

  Choose the Application 
program by clicking the 
Browse button and 
locating the executable on 
the remote machine  
  Use the same “shallow” 

executable 
  Select Display output 

from all processes in a 
console view 

  If Debugger tab has error, 
select Debugger: SDM 

  Click Run to submit the 
application to the job 
scheduler 
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Running the Interactive job 

 Maximizing the 
console, you can see 
output from the job 

 Use Run button to 
re-run application 
within the interactive 
run 

 Use Stop button to 
end batch job 
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Module 5: Parallel Debugging 

 Objective 
 Learn the basics of debugging parallel programs 

 Contents 
 Launching a debug session 
 The Parallel Debug Perspective 
 Controlling sets of processes 
 Controlling individual processes 
 Parallel Breakpoints 
 Terminating processes 
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Debugging an Application 

  Debugging requires interactive access to the application 
  Since PBS is for batch execution, we will use Open MPI to 

provide interactive access to the machine (PBS will 
support interactive execution in the future) 

  First switch to the Parallel Runtime perspective if not 
already there 
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Start the Resource Manager 

  If the Open_MPI Resource manager is not already 
started (green icon), start it now: 
  Right-click on the resource manager and select 

Start Resource Manager from the menu 
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Create a Debug Configuration 

  A debug configuration is 
essentially the same as a run 
configuration (like we used 
in modules 3 & 4) 

  We will re-use the existing 
configuration and add debug 
information 

  Use the drop-down next to 
the debug button (bug icon) 
instead of run button 

  Select Debug 
Configurations… to open 
the Debug Configurations 
dialog 
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Configure the Debugger Tab 

  Select Debugger tab 
  Select the shallow 

configuration 

  Make sure SDM is 
selected in the 
Debugger dropdown 

  Check the debugger 
path is correct 
  Should be the path to 

the sdm executable on 
the remote system 

  Debugger session 
address should not 
need to be changed 

  Click on Debug to 
launch the program 
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  Parallel Debug 
view shows job 
and processes 
being debugged 

  Debug view shows 
threads and call 
stack for individual 
processes 

  Source view 
shows a current 
line marker for all 
processes 

The Parallel Debug Perspective (1) 
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The Parallel Debug Perspective (2) 

  Breakpoints view 
shows breakpoints 
that have been set 
(more on this later) 

  Variables view 
shows the current 
values of variables 
for the currently 
selected process in 
the Debug view  

  Outline view (from 
CDT) of source 
code 
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Stepping All Processes 

  The buttons in the 
Parallel Debug View 
control groups of 
processes 

  Click on the Step Over 
button 

  Observe that all process 
icons change to green, 
then back to yellow 

  Notice that the current 
line marker has moved to 
the next source line 
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Stepping An Individual Process 
  The buttons in the 

Debug view are used 
to control an 
individual process, in 
this case process 0 

  Click the Step Over 
button 

  You will now see two 
current line markers, 
the first shows the 
position of process 0, 
the second shows the 
positions of processes 
1-3 
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Process Sets (1) 

  Traditional debuggers apply operations to a single 
process 

  Parallel debugging operations apply to a single process 
or to arbitrary collections of processes  

  A process set is a means of simultaneously referring to 
one or more processes 

5-9 



Module 5 

Process Sets (2) 

  When a parallel debug session is first started, all 
processes are placed in a set, called the Root set  

  Sets are always associated with a single job 
  A job can have any number of process sets 
  A set can contain from 1 to the number of processes in 

a job 
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Operations On Process Sets 

  Debug operations on the 
Parallel Debug view 
toolbar always apply to the 
current set: 
  Resume, suspend, stop, 

step into, step over, step 
return 

  The current process set is 
listed next to job name 
along with number of 
processes in the set 

  The processes in process 
set are visible in right hand 
part of the view 

Root set = all processes 
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Create set Remove  
from set 

Delete 
set 

Change 
current set 

Managing Process Sets 

  The remaining icons in the toolbar of the Parallel 
Debug view allow you to create, modify, and delete 
process sets, and to change the current process set 

5-12 



Module 5 

Creating A New Process Set 
  Select the processes 

you want in the set by 
clicking and dragging, 
in this case, the last 
three 

  Click on the Create 
Set button 

  Enter a name for the 
set, in this case 
workers, and click OK 

  You will see the view 
change to display only 
the selected processes 
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Stepping Using New Process Set 
  With the workers set 

active, click the Step 
Over button 

  You will see only the 
first current line 
marker move 

  Step a couple more 
times 

  You should see two line 
markers, one for the 
single master process, 
and one for the 3 
worker processes 
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Process Registration 

 Process set commands apply to groups of 
processes 

 For finer control and more detailed 
information, a process can be registered and 
isolated in the Debug view 

 Registered processes, including their stack 
traces and threads, appear in the Debug view 

 Any number of processes can be registered, 
and processes can be registered or  
un-registered at any time 
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Process Registration (2) 
  By default, process 0 was 

registered when the debug 
session was launched 

  Registered processes are 
surrounded by a box and 
shown in the Debug view 

  The Debug view only shows 
registered processes in the 
current set 

  Since the “workers” set 
doesn’t include process 0, it 
is no longer displayed in the 
Debug view 
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Registering A Process 

  To register a process, 
double-click its process 
icon in the Parallel 
Debug view or select a 
number of processes and 
click on the register 
button 

  To un-register a process, 
double-click on the 
process icon or select a 
number of processes and 
click on the unregister 
button 

Individual 
(registered) 
processes 

Groups (sets) 
of processes 
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Current Line Marker 

 The current line marker is used to show the 
current location of suspended processes 

 In traditional programs, there is a single 
current line marker (the exception to this is 
multi-threaded programs)  

 In parallel programs, there is a current line 
marker for every process 

 The PTP debugger shows one current line 
marker for every group of processes at the 
same location 
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Multiple processes marker  

Registered process marker 

Un-registered process marker 

Colors And Markers 

  The highlight color depends on 
the processes suspended at 
that line: 
  Blue: All registered process(es) 
  Orange: All unregistered process

(es) 
  Green: Registered or unregistered 

process with no source line (e.g. 
suspended in a library routine) 

  The marker depends on the 
type of process stopped at that 
location 

  Hover over marker for more 
details about the processes 
suspend at that location 
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  Apply only to processes in the particular set that is 
active in the Parallel Debug view when the breakpoint 
is created 

  Breakpoints are colored depending on the active 
process set and the set the breakpoint applies to: 
 Green indicates the breakpoint set is the same  

as the active set. 
  Blue indicates some processes in the breakpoint set are 

also in the active set (i.e. the process sets overlap)  
  Yellow indicates the breakpoint set is different from the 

active set (i.e. the process sets are disjoint) 
  When the job completes, the breakpoints are 

automatically removed 

Breakpoints 
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Creating A Breakpoint 
  Select the process set that 

the breakpoint should apply 
to, in this case, the workers 
set 

  Double-click on the left edge 
of an editor window, at the 
line on which you want to set 
the breakpoint, or right click 
and use the Parallel 
BreakpointToggle 
Breakpoint context menu 

  The breakpoint is displayed 
on the marker bar 
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Hitting the Breakpoint 
  Switch back to the Root set 

by clicking on the Change 
Set button 

  Click on the Resume button 
in the Parallel Debug view 

  In this example, the three 
worker processes have hit the 
breakpoint, as indicated by 
the yellow process icons and 
the current line marker 

  Process 0 is still running as its 
icon is green 

  Processes 1-3 are suspended 
on the breakpoint 

5-22 



Module 5 

More On Stepping 
  The Step buttons are only 

enabled when all processes 
in the active set are 
suspended (yellow icon) 

  In this case, process 0 is still 
running 

  Switch to the set of 
suspended processes (the 
workers set) 

  You will now see the Step 
buttons become enabled 
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Breakpoint Information 

 Hover over breakpoint icon 
 Will show the sets this breakpoint applies to 

 Select Breakpoints view 
 Will show all breakpoints in all projects 
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 Use the menu in the breakpoints view to group 
breakpoints by type 

 Breakpoints sorted by breakpoint set (process 
set) 

Module 5 

Breakpoints View 
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  Apply to all processes and all jobs 
  Used for gaining control at debugger startup 
  To create a global breakpoint 

  First make sure that no jobs are selected (click in white 
part of jobs view if necessary) 

 Double-click on the left edge of an editor window 
 Note that if a job is selected, the breakpoint will apply to 

the current set 

Global Breakpoints 
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Terminating A Debug Session 

  Click on the Terminate 
icon in the Parallel 
Debug view to 
terminate all processes 
in the active set 

  Make sure the Root set 
is active if you want to 
terminate all processes 

  You can also use the 
terminate icon in the 
Debug view to 
terminate the currently 
selected process 
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Module 6: Fortran 

 Objective 
 Learn what Photran is and how it compares to CDT 
 Learn how to create a Fortran MPI application 
 Learn about refactoring support 

 Contents 
 Overview of Photran 
 Module 3 redux (in Fortran) 
 Differences between Photran and CDT 
 Pointers to online documentation for Photran 
 Refactoring support 
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Ralph Johnson’s research group at UIUC used to meet at Pho-Tran… 



…which became the name of their Fortran IDE. 



Photran 
•  http://www.eclipse.org/photran 
•  Official Eclipse Foundation project; 

part of the Parallel Tools Platform (PTP) 

•  Supports Fortran 77, 90, 95, 2003, & 2008 
•  Built on CDT; largely similar to it 

•  Primary contributor: UIUC 
•  Contrib’s from Intel, IBM, LANL, & others 
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Fortran 
Editor & 
Outline 
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Context- 
Aware 

Highlighting 
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CVS 
support 
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Debugging 
(GDB GUI) 
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Installing Photran 

  You will need a Fortran compiler 
(e.g., gfortran), make, and gdb to 
compile & debug Fortran programs 

  From the Help menu, choose  
      Install New Software… 

  Select the Indigo update site 

 Under Programming Langs 
Check Fortran Dev. Tools 

  Click Next 
  Finish installing: 

  Next, Accept license, Finish 
  Features and prerequisites 

are downloaded and installed… 
  Restart Eclipse when prompted 
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Using Photran 

 It’s just like using CDT... 
 Similar New Project wizards 
 Similar build procedure 
 Similar launch/debug procedure 

 ...but not exactly 
 Remote development partially supported 
 Configuring fixed vs. free form file extensions 
 Different editor features 
 Different advanced features 
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Switch to C/C++ Perspective 
 Only needed if 

you’re not 
already in the 
perspective 

 What Perspective 
   am in in? 
   See Title Bar 

Fortran 
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(same as for C/C++) 



Creating a Fortran Application 

Steps: 
  Create a new Fortran project 
  Edit source code 
  Save and build 
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(same as Creating a C/C++ Application) 



New Fortran Project Wizard 

Create a new MPI project 
  FileNewFortran Project 

(see prev. slide) 
  Name the project   

‘MyHelloProject’  
  Under Project types, under 

Makefile Project,  select MPI 
Hello World Fortran Project 
and hit Next  

  On Basic Settings 
page, fill in information 
for your new project 
(Author name etc.) 
and hit Finish 

There are  
“Managed Build” 
projects for 
Fortran too… 

…but this is a 
Makefile project, 
where you 
maintain the 
Makefile 
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(similar to New C/C++ Project Wizard) 



Fortran Projects View 

  Represents user’s data 
  It is a set of user defined 

resources 
 Files 
 Folders 
 Projects 

 Collections of files and 
folders 

 Plus meta-data 
  Resources are visible in the 

Fortran Projects View 
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(similar to C/C++ Project Explorer view) 



Editor and Outline View 
  Double-click on 

source file to 
open Fortran 
editor 

  Outline view is 
shown for file in 
editor 
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(similar to C/C++) 



Build 

  Your program should build when created. 
  To rebuild, many ways include: 

  Select project, Hit hammer icon in toolbar 
  Select project, Project  Build Project 
  Right mouse on project, Clean Project 
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(same as C/C++) 



Et Cetera 
  Creating a launch configuration is identical 

(Suggestion: Uncheck Stop on startup at main  
in the Debugger tab) 
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Et Cetera 

 Debugging is identical 

 Launching a parallel application is identical 

 Debugging a parallel application is identical 
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Diagnosing Common Problems 

  Right-click on the project 
in the Fortran Projects 
view, and choose 
Properties 

  Expand Fortran 
BuildSettings 

  Switch to the Error 
Parsers tab 

  Are Photran’s error parsers 
checked?  If not, click 
Check all 

  Click OK and re-build 

Building: Are compile errors 
not shown in the Problems 
view? 
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(also true for C/C++) 

  Right-click on the project in 
the Fortran Projects view, 
and choose Properties 

  Expand Fortran 
BuildSettings 

  Switch to the Binary 
Parsers tab 

  Make sure the parser for 
your platform is checked 
    PE = Windows 
    Elf = Linux 
    Mach-O = Mac OS X 

  Click OK 

Launching: Is a binary not 
listed when creating a launch 
configuration? 



Differences (1): MPI Project Wizard 

  In the MPI Hello World C Project (local project), 
the MPI compiler is set in the project settings… 
(Local, managed build project: see Module 7, Advanced 
Features) 

  …but in the MPI Hello World Fortran Project, 
the MPI compiler is set in a Makefile. 
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Differences (2): Content Assist 

  Content assist is disabled by default. 
(So are Declaration View, Hover Tips, Fortran Search, & 
refactorings.) 
You must specifically enable it for your project. 

  Right-click on the 
project in the Fortran 
Projects view, and 
choose Properties 

  Expand Fortran 
Analysis/Refactoring 

  Check Enable Fortran 
analysis/refactoring 

  Click OK 
  Close and re-open any 

Fortran editors 
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Differences (3): Source Form 
 Fortran files are either free form or fixed form; 

some Fortran files are preprocessed (#define, #ifdef, etc.) 

 Determined by filename extension 
 Source form is set in the project properties 

  Defaults: 

    Fixed form:  .f  .fix  .for  .fpp  .ftn  .f77 

    Free form:  .f08  .f03  .f95  .f90   < unpreprocessed 
 .F08  .F03  .F95  .F90  < preprocessed 

 Many features will not work if filename extensions 
are associated incorrectly 
(Outline view, content assist, Fortran Search, refactorings, 
Open Declaration, …) 
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Differences (3): Source Form 

  Right-click a project 
in the Fortran 
Projects view 

  Click Properties 

  Navigate the tree to 
Fortran General 
Source Form   

  Select source form 
for each filename 
extension 

  Click OK 

Set free/fixed form associations in the project properties 
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Differences (3): Source Form 

  Navigate the tree 
to General 
Content Types 

  Expand Text 
Fortran Source 
File 

  Add custom 
filename 
extensions 

Add new filename extensions in workspace preferences 
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Differences (4): Remote Support 

  Remote Fortran support is improving 

  Synchronized remote projects 

  Create Synchronized C/C++ Project, then 
Convert to Fortran Project 

  All features should work, except no support for 
remote INCLUDE/#include files 

  Fully remote projects 

  Create Remote C/C++ Project, then 
Convert to Fortran Project 

  Do not enable analysis/refactoring 
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For More Information 

  Photran online documentation 
linked from http://www.eclipse.org/photran 

 Installation Guide 

 User’s Guide 
General introduction, basic features 

 Advanced Features Guide 
Features requiring analysis/refactoring to be enabled 
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Refactoring 

  Refactoring is the research 
motivation for Photran @ Illinois 
  Illinois is a leader in refactoring research 

  “Refactoring” was coined in our group 
(Opdyke & Johnson, 1990) 

  We had the first dissertation… 
(Opdyke, 1992) 

  …and built the first refactoring tool… 
(Roberts, Brant, & Johnson, 1997) 

  …and first supported the C preprocessor 
(Garrido, 2005) 

  Photran’s agenda: refactorings for HPC, 
language evolution, refactoring framework 

  Photran 6.0: 16 refactorings 
           Photran 7.0: 31 refactorings 

(making changes to source code that don’t affect the behavior of the program) 
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In Java (Murphy-Hill et al., ICSE 2008): 

Rename Refactoring 
 Changes the name of a variable, function, etc., 

including every use 
(change is semantic, not textual, and can be workspace-wide) 

 Only proceeds if the new name will be legal 
(aware of scoping rules, namespaces, etc.) 

  Select Fortran Perspective 
 Open a source file 
  Click in editor view on 

declaration of a variable 
  Select menu item 

RefactorRename 
 Or use context menu 

  Enter new name 
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(also available in C/C++) 



  Moves statements into a new subroutine, replacing the 
statements with a call to that subroutine 

  Local variables are passed as arguments 

Extract Procedure Refactoring 

  Select a sequence of statements 
  Select menu item 

RefactorExtract Procedure… 
 Or use context menu 

  Enter new name 
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(also available in C/C++ - “Extract Function”) 



  Fortran does not require variable declarations 
(by default, names starting with I-N are integer variables; others are reals) 

  This adds an IMPLICIT NONE statement and adds explicit 
variable declarations for all implicitly declared variables 

Introduce IMPLICIT NONE Refactoring 

  Introduce in a single file by 
opening the file and selecting 
RefactorIntroduce IMPLICIT 
NONE… 

  Introduce in multiple files by 
selecting them in the Fortran 
Projects view, right-clicking on 
the selection, and choosing 
RefactorIntroduce IMPLICIT 
NONE… 
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Module 7: Advanced Development 

 Objective 
 Become familiar with other tools that help 

parallel application development 

 Contents 
 Parallel Language Development Tools: MPI, OpenMP, UPC 

 Overview of UPC tools 
 Performance Tuning and other external tools:  

 PTP External Tools Framework (ETFw), TAU 
 Parallel Performance Wizard (PPW)  

 MPI Analysis: GEM (Graphical Explorer of MPI Programs) 
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Eclipse UPC Features 

Module 7 7-1 

 CDT:  
 Parser/Editor support 
 Code templates 
 IBM XLc (incl. xlUPC) – remote 
 Berkeley UPC toolchain – local (see backup slides) 

 PTP: 
 Artifact identification; Hover/dynamic help assistance 
 More Code templates 
 Remote UPC parsing and builds with xlupc 
 Parallel Performance Wizard integration with PTP 



CDT - UPC Support 

  Filetypes of “upc” will get UPC syntax high- 
lighting, content assist, etc. 

  Use Preferences to  
change default for *.c 
if you like 
(we’ll show you how) 
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UPC Content Assist, Hover Help 

  In Editor, type 
upc and hit control-
space 
(once) 

  A list of possible 
completions is 
provided.   

  Choose with mouse 
or cursor. 

  Hover over 
API 

  Hyperlink too 
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UPC templates - using 

  In Editor, type 
upc and hit control-space 
(twice) 
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UPC templates – viewing/adding 

  Eclipse preferences: add 
more! Or just see 
what’s there 
 C/C++ > Editor > 

Templates 
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Show UPC Artifacts 

  Add some UPC api’s to your sample project 
  Show UPC Artifacts – remote projects need CDT > 8.0 
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Other UPC features 

 UPC parser is remote-enabled 
 Remote UPC projects can be developed efficiently 

 Remote xlUPC toolchain enables remote build 
of IBM xlUPC project 
 Managed Build (user-friendly) way to specify and 

manage complex build options without makefiles 
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More Advanced Features: Demos 

 ETFw – External Tools Framework and 
TAU, Tuning and Analysis Utilities 
 Suzanne Millstein, U. Oregon  

 PPW – Parallel Performance Wizard 
 No demo today) 

 GEM – Graphical Explorer of MPI Programs 
    Dynamic Formal Verification for MPI 
 Alan Humphrey, U. Utah 
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PTP/External Tools Framework 
formerly “Performance Tools Framework” 

Goal: 
 Reduce the “eclipse plumbing”  

necessary to integrate tools 
 Provide integration for 

instrumentation, measurement, and 
analysis for a variety of performance 
tools 

  Dynamic Tool Definitions:  
Workflows & UI 

  Tools and tool workflows are 
specified in an XML file 

  Tools are selected and configured in 
the launch configuration window 

  Output is generated, managed and 
analyzed as specified in the 
workflow 
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PTP TAU plug-ins  
http://www.cs.uoregon.edu/research/tau 

  TAU (Tuning and Analysis Utilities) 
  First implementation of External Tools Framework (ETFw) 
  Eclipse plug-ins wrap TAU functions, make them available 

from Eclipse 
  Compatible with Photran and CDT projects and with PTP 

parallel application launching 
  Other plug-ins launch Paraprof from Eclipse too 
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TAU Integration with PTP 

 TAU: Tuning and 
Analysis Utilities 
 Performance data 

collection and analysis 
for HPC codes 

 Numerous features 
 Command line interface 

 The TAU Workflow: 
 Instrumentation 
 Execution 
 Analysis 
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Parallel Performance Wizard (PPW) 
  Full-featured performance tool for 

PGAS programming models 
  Currently supports UPC, SHMEM, and 

MPI 
  Extensible to support other models 
  PGAS support by way of Global Address 

Space Performance (GASP) interface 
(http://gasp.hcs.ufl.edu) 

  PPW features: 
  Easy-to-use scripts for backend data 

collection 
  User-friendly GUI with familiar 

visualizations 
  Advanced automatic analysis support 

  More information and free 
download: http://ppw.hcs.ufl.edu 
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  We implement the ETFw to make 
PPW’s capabilities available within 
Eclipse 
  Compile with instrumentation, 

parallel launch with PPW 
  Generates performance data file in 

workspace, PPW GUI launched 

  PPW is often used for UPC 
application analysis 
  ETFw extended to support UPC 
  Many UPC features in PTP 

  For more information: 

 http://ppw.hcs.ufl.edu 
 ppw@hcs.ufl.edu 

PPW Integration via ETFw 
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GEM 
Graphical Explorer of MPI Programs 

 Contributed to PTP by University of Utah in 2009 
  Available with PTP since v3.0 

 Dynamic verification for MPI C/C++ that detects: 
 Deadlocks 
 MPI object leaks 
  Functionally irrelevant barriers 
  Local assertion violations 

 Offers rigorous coverage guarantees 
  Complete nondeterministic coverage for MPI 
  Communication / synchronization behaviors 
 Determines relevant interleavings, replaying as necessary 
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GEM - Overview 

(Image courtesy of Steve Parker, U of Utah) 

7-15 

  Front-end for In-situ Partial Order 
(ISP), Developed at U. Utah 

  Introduces “push-button” 
verification into the MPI 
development cycle for PTP 

  Automatically instruments and runs 
user code, displaying post 
verification results 

  Variety of views & tools to facilitate 
debugging and code understanding 



GEM – Views & Tools 
 Analyzer View 

 Highlights bugs, and facilitates 
 post-verification review / debugging 
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Browser View 
Groups & helps quickly localizes 

MPI problems. Maps errors to 
source code line in editor 



GEM – Views & Tools (cont.) 

17 

 Happens-Before Viewer 
Shows required orderings and communication matches 

(currently an external tool) 
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Using GEM – ISP Installation 

 ISP itself must be installed prior to using GEM 

 Download ISP at http://www.cs.utah.edu/fv/ISP 

 Make sure libtool, automake and autoconf are installed. 

 Just untar  isp-0.2.0.tar.gz into a tmp directory: 
 Configure and install 

 ./configure 
 make 
 make install 

  This installs binaries and necessary scripts 



Using GEM 
 Create local or remote MPI C/C++ project 

 Make sure your project builds correctly 
 Managed build and Makefile projects supported 

 Set preferences via GEM Preference Pages 
 From the trident icon or context 

menus user can: 

 Formally Verifying MPI Program  
 Launches verification engine ISP 
 Generates log file for post-

verification analysis 
 Opens relevant GEM views 
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GEM Analyzer View 
 Reports program errors, and runtime statistics 

 Debug-style source code stepping of interleavings 
 Point-to-point / Collective Operation matches 
 Internal Issue Order / Program Order views 
 Rank Lock feature – focus on a particular process 

 Also controls: 
 Call Browser 
 Happens Before Viewer launch 
  Re-launching of GEM 
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GEM Browser View 
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 Tabbed browsing for each type of MPI error/warning 

 Each error/warning mapped to offending line of 
source code in Eclipse editor 

 One click to visit the Eclipse editor, to examine: 
 Calls involved in deadlock  
 Irrelevant barriers 
 MPI Object Leaks sites 
 MPI type mismatches 
  Local Assertion Violations 



GEM – Help Plugin 
Extensive how-to sections,  graphical aids and 

trouble shooting section 
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GEM/ISP Success Stories 
 Umpire Tests  

  http://www.cs.utah.edu/fv/ISP-Tests 
 Documents bugs missed by tests, caught by ISP 

 MADRE (EuroPVM/MPI 2007) 
  Previously documented deadlock detected 

 N-Body Simulation Code 
  Previously unknown resource leak caught during  
   EuroPVM/MPI 2009 tutorial ! 

 Large Case Studies 
  ParMETIS, MPI-BLAST, IRS (Sequoia Benchmark), and a few 

SPEC-MPI benchmarks could be handled 

 Full Tutorial including LiveDVD ISO available 
  Visit http://www.cs.utah.edu/fv/GEM 
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GEM Future Plans 

 Incorporation of HB Viewer into GEM as a new view 

 Add Pthread support to visualize Pthread calls made 
from within MPI space 



GEM Future Plans 
 GEM will serve as a front-end for other tools 

 Integration of Distributed Analyzer of MPI Programs 
(DAMPI), developed at University of Utah 
 ISP scales to 10s of processes 
 DAMPI scales to 1000s of processes (C/C++/Fortran) 
 Decentralized scheduler uses Lamport Clocks 
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Use ISP at small scale, 
then launch DAMPI at 

scale on a cluster 	





PTP Adv. Development: Summary 

 A diversity of other tools aid parallel development 
 Parallel Language Development Tools:  

MPI, OpenMP, UPC, LAPI, etc. 
 External Tools Framework (ETFw) eases integration of 

existing (command-line, etc.) tools 
 TAU Performance Tuning uses ETFw 
 PPW (Parallel Perf. Wizard) uses ETFw for UPC analysis 
 Feedback view maps tool findings with source code 

 MPI Analysis: GEM 

 A diversity of contributors too! 
 We welcome other contributions. Let us help! 
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Backup 

 Not covered in today’s tutorial, 
but included for reference 

 Creating a local MPI project, and using the wizards 
 MPI Assistance tools  
 MPI Barrier analysis on a local project 

 OpenMP tools 
 UPC tools installation and local projects 
 External Tools Framework (ETFw) details, overview 

of integrating other tools into PTP 
 ETFw Feedback view incl. sample exercise 
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Parallel Lang. Dev. Tools 
 PLDT Features 

 Analysis of C and C++ code to determine the 
location of MPI, OpenMP, and UPC Artifacts 

 Content assist via ctrl+space (“completion”) 
 Hover help  
 Reference information about the API calls via Dynamic 

Help 
 New project wizard automatically configures managed 

build projects for MPI & OpenMP 
 OpenMP problems view of common errors 
 OpenMP “show #pragma region” , “show concurrency” 
 MPI Barrier analysis - detects potential deadlocks 

Some MPI features were covered in Module 4 
Note: Some PLDT features don’t work on remote (RDT) projects 
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Added by PLDT (Parallel Lang. Dev. Tools) 
feature of PTP 

 MPI Context sensitive help 
 MPI artifact locations 
 MPI barrier analysis 
 MPI templates 

 For this part, we will use the local MPI New 
Project Wizard and the “MPI Hello World” 
project 

MPI Assistance Tools 
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Creating Local Project 

 The next slide shows you how to create a local 
MPI project. 

 If you do not have MPI on your local machine, 
you can’t build or run. 

 But you should be able to demonstrate the MPI 
features in PTP’s PLDT regardless. 

 Several PLDT MPI features pertain to developing 
code – just using the local editor, etc.  

 Most PLDT features do work on remote projects. 
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Create local MPI Project 

Using a Managed 
Build Project – for a 
quick sample local  
MPI project 
 File > New > C 
Project 
 Give Project a 
name, e.g. HelloMPI 
 Confirm Toolchain 
 Select MPI Hello 
World C Project 
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Set MPI Preferences 
  When creating a local 

MPI project with the 
wizard, you need to set 
MPI Preferences (once) 

  This assures the include 
paths, etc.  will be set 
for new MPI projects – 
for building, and for 
Eclipse assistance 
features for MPI. 

  Select Yes to set the MPI 
preferences.���
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Note: if you do not have MPI on your local 
machine, you can use just an MPI header 
file (mpi.h) so you play with the PTP MPI 
development features without building or 
running on your local machine.	



No 
MPI? 



Set MPI Preferences (2) 

  On the MPI 
Preferences page, add 
a new MPI include 
path. 

  New … and point to 
the directory 
containing your MPI 
header file (mpi.h) 

  Select OK 
  Back on New Project 

Wizard page, select 
Next> and fill in 
Author name, etc. 
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Review MPI Project Settings 

  On the next wizard page, 
review the MPI project 
settings based on the 
information you have 
provided.   

  Make changes if you wish. 
  The defaults should be fine. 
  Click Finish.  
  You will be prompted to 

switch perspectives 
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Create MPI Project 

Recap: 
  File > New > C Project 
  Give Project a name, e.g. 

HelloMPI 
  Select Toolchain 
  Select MPI Hello World C 

Project 
  Set MPI Prefs, if first time 
  Click Finish 

  Note: if it doesn’t build on 
your machine, you can still 
continue with this exercise 
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Project Properties:  
Managed Build Project 

 Right-click on project in Project Explorer 
view and select Properties 

 Project Properties for Managed Build project 
 Compiler, Linker, etc. settings set automatically 

without a Makefile  
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Show MPI Artifacts 

  Markers indicate the 
location of artifacts in 
editor 

  In MPI Artifact View 
sort by any column 
(click on col. heading) 

  Navigate to source code 
line by double-clicking 
on the artifact 

  Run the analysis on 
another file and its 
markers will be added to 
the view 

  Remove markers via  
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  Select source file in Project Explorer; 
Select Show MPI Artifacts  
in PLDT menu 



MPI Barrier Analysis 
Verify barrier 
synchronization in C/
MPI programs 

Interprocedural static 
analysis  outputs: 

 For verified programs, 
lists barrier statements 
that synchronize 
together (match) 
  For synchronization 
errors, reports counter 
example that illustrates 
and explains the error  
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Local 
files only 



MPI Barrier Analysis – Try it 

Resulting statement 

Module 7 7-40 

Add some barriers: 
  Inside the sample if

(rank…) add a barrier: 
  Use Content Assist to 

help you type 
  Type: MPI_  and press 

Ctrl-space.  See 
completion alternatives. 
Keep typing until you see 
MPI_Barrier and hit enter. 

  For args, start typing 
MPI_Comm_  etc. and it 
will also complete 
MPI_COMM_WORLD 

  Add the same barrier 
statement at the end of 
the else as well. 



MPI Barrier Analysis – Try it (2) 
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Run the Analysis: 
  In the Project Explorer, 

Select the source file (or 
directory, or project) of 
file(s) to analyze 

  Select the MPI Barrier 
Analysis action in the 
menu���



MPI Barrier Analysis - views 

MPI Barriers view 

Simply lists the barriers 

Like MPI Artifacts view, 
double-click to navigate 
to source code line (all 
3 views) 

Barrier Matches view 
Groups barriers that 
match together in a 
barrier set – all 
processes must go 
through a barrier in the 
set to prevent a 
deadlock 

Barrier Errors view  

If there are errors, a 
counter-example 
shows paths with 
mismatched number 
of barriers  
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MPI Templates 

 Eclipse preferences: add more! 
 C/C++ > Editor > Templates 

 Extend to other common patterns 
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  Allows quick entry of 
common patterns in MPI 
programming 

  Example: MPI send-
receive 

  Enter: mpisr <ctrl-
space> 

  Expands to the code 
shown at right 

  Highlighted variable 
names can all be 
changed at once 

  Type mpi <ctrl-space> 
<ctrl-space> to see all 
templates 



OpenMP Managed Build 
Project   

  This will need OpenMP 
preferences (e.g. include file 
location) set up as well 

  Create a new OpenMP project 
  FileNewC Project 
 Name the project e.g. 

‘MyOpenMPproject’  
  Select Toolchain 
  Select OpenMP Hello 

World C Project 
  Select Next, then fill in 

other info like MPI project 
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Setting OpenMP Special 
Build Options 

  OpenMP typically requires  
special compiler options. 
 Open the project  

properties 
 Expand C/C++ Build 
 Select Settings 
 Select C Compiler 

 In Miscellaneous,  
add option(s). 
-fopenmp 

  Click OK; Project should 
attempt to build  
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Show OpenMP Artifacts 

  Select source file, 
folder, or project 

  Run analysis 

  See artifacts  in 
OpenMP Artifact 
view 
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Show Pragma Region 

  Run OpenMP 
analysis 

  Right click on  
pragma in  
artifact view 

  Select Show  
pragma region 

  See highlighted region in C editor 
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UPC 
   
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UPC Features Installation 
 If you installed PTP PLDT UPC feature, you should 

have CDT UPC feature too 

  See Also: 
http://wiki.eclipse.org/PTP/other_tools_setup#Using_UPC_features 

  You can also install UPC features from the CDT-specific update site 
  Enable it in update manager 
 Help, Install New Software, Click available Software Sites link 
  Check the CDT site: 

http://download.eclipse.org/tools/cdt/releases/helios 
  Click OK to return to Install dialog 
  In Work with:  select the CDT site you enabled 
  Check UPC features 

  Finish install 
and restart 
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BUPC toolchain 
only on CDT site  



UPC syntax in .c files 

 UPC syntax is 
recognized by the 
parser in *.upc 
files 

 Copy helloUPC.upc 
to hello.c to see 
the difference 

Module 7 7-50 

Keywords as 
well as new 
syntax are 
recognized 

Highlight color  

No Highlight color  



UPC syntax in .c files (2) 

 To enable UPC syntax in *.c files, we will  
change the language mappings 

 Preferences, C/C++, Language Mappings 
 Click the Add… button to add a Language 

mapping. 
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 For Content Type, 
C Source File 

 For Language,  
select UPC 

 Click OK, OK 



UPC syntax in .c files (3) 

 Now UPC syntax 
is recognized 
in both types 
of files 

 You may need 
to close and 
re-open a file 
to see the change. 

 Note: in Project Properties, you can do this 
for just individual projects. 
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Berkeley UPC toolchain 

 Local projects only 
 File > New >  

C project 
 Hello World 

UPC project 
 Select toolchain 

(if you don’t have 
the toolchain, it just 
won’t build.) 

 Next, Next, Finish 
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BUPC toolchain 

 Bring up 
Project   
Properties to 
see details 
of BUPC 
toolchain: 

 Project,  
right mouse, 
Properties 
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Hello World UPC project 

 Hello (Berkeley) World UPC project 
 Note UPC syntax highlighting 
 Toolchain has been modified for UPC 
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UPC on abe.ncsa.uiuc.edu 

  BUPC is located at: 
  /usr/apps/mpi/upc/berkeley_upc 

  To run from cmd line on abe: 
  setenv PATH /usr/apps/mpi/upc/berkeley_upc/bin:${PATH} 

TO RUN FROM PTP/ECLIPSE: 
  In your home dir on abe: use ‘helloUPC’ to make a remote proj 
  Set Remote Paths and Symbols to include: 

  /usr/apps/mpi/upc/berkeley_upc/opt/include/upcr_preinclude 
  To run: use a Generic Remote Launch for Resource Manager 
  Run config: 

  Application program: /usr/apps/mpi/upc/berkeley_upc/bin/
upcrun 

  Arguments tab: -q -n 4 ~/helloUPC/helloUPC 
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External Tools Framework 
ETFw Motivation 

 There are numerous command-line oriented 
development tools employed in HPC 

 These can be complicated or time consuming 
to use 

 IDE integration for individual development 
tools is slow and inconsistent 

 We want all our development tools in one 
place with one interface 

 We want our development tools to work 
together 
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ETFw: Development Tool 
Workflows 

 Variations on ‘Compile, Execute, Analyze-
Results’ are common to most software 
development 

 These steps may be tedious and time 
consuming, especially over multiple iterations 

 By defining both tool interfaces and behavior 
in an XML document these steps can be 
simplified and automated 
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ETFw: The Build Phase 

 Set compilers and arguments for each language 
 Define UI for compiler/compiler-wrapper 

configuration 
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ETFw: The Execution Phase 

 Specify composed execution tools such as 
Perfsuite or Valgrind 

 Set launch environment variables 
 Define variables and tool options in XML or 

provide a UI in the IDE 
 Integrates with PTP parallel launch 

environment 
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ETFw: The Analysis/Post-
Processing Phase 

 Sequentially run 
tools on program 
output 

 Launch external 
visualization tools 
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ETFw: XML-Defined UI 
Components 

 Each pane constructs a set of options 
sent to a tool or a set of environment 
variables 

 Numerous options for converting a 
command line interface into an 
intelligent GUI without Eclipse coding 
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ETFw: Advanced Components 

 Extension points 
allow integration with 
UIs and workflow 
behavior too complex 
to define in XML 

 Logical and iterative 
workflows for 
successive executions 
and parametric 
studies 
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ETFw: Using Workflows 

 New workflows are 
added to the ETFw 
launch configuration 
system 

 Multiple workflow 
configurations can be 
defined and saved for 
different use cases 

 XML Workflow 
definitions can be saved 
and reused in different 
environments 
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ETFw: General Purpose Workflow 

 Automated 
 Generalized 
 Quick performance 

analysis and other 
development tool 
integration 

 Exposes tool 
capabilities to the user 
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ETFw: Continuing Development 

Plans: 
 Integration with PTP Remote Development 

Tools 
 Additional options for GUI definition 
 Generalization of TAU specific features such as 

hardware counter selection and performance 
data storage 

 Contact: Wyatt Spear 
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  Many existing tools provide 
information that can be mapped to 
source code lines 
  Compiler errors, warnings, 

suggestions 
  Performance tool findings 

  ETFw feedback view provided to 
aid construction of these views 
  Currently geared toward data 

provided by tools in XML files 
  Original ETFw facilities aid the 

CALL of external tools from PTP 
  Feedback view aids the 

exposition of results to the 
user 

ETFw Feedback view 
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Examples: 
  Compiler optimization 

report 
  Performance tool data 
  Refactoring tool uses 

“advice” from external files 



Feedback Sample 
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 Download a sample implementation of the 
feedback view: 

 Complete instructions here:  
http://wiki.eclipse.org/PTP/ETFw/feedback 

 And on following slide… 



Feedback Sample – (1) Install 
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 Download the plugin jar file 
  http://download.eclipse.org/tools/ptp/misc/feedback/

org.eclipse.ptp.etfw.feedback.sample_1.0.0.201010280927.jar 

 Save it in your eclipse/dropins directory 
 This is a “quick and dirty” type of installation 
 Eclipse knows to look here when it starts, and it 

installs whatever it finds here 

 Then restart eclipse 
   You should see the feedback icon 



Feedback Sample – (2) data files 
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 You have the Feedback sample plug-in installed 
 Now you need some sample files for it to process 

 sample.c and sample.xml 
 They are hidden in the plug-in! 
 Let’s take it apart to find them 
 Unzip the jar file; they are in the data/  directory 

 Alternate instructions on the wiki page 
 Put them in a (local) eclipse project 



Feedback Sample – (3) Try it 
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 You have the Feedback sample plug-in installed 
 You have an xml file that it can parse, and the 

source file that it refers to. 

1.  Select xml file 

2.  Click feedback button 
3.  See Sample Feedback 

view 
4.  Double-click in view 

to navigate to source 
code lines 



END 
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Module 8: Other Tools and 
Wrap-up 

 Objective 
 How to find more information on PTP 
 Learn about other tools related to PTP 
 See PTP upcoming features 

 Contents 
 Links to other tools, including performance tools 
 Planned features for new versions of PTP 
 Additional documentation 
 How to get involved 
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NCSA 
HPC Workbench 

  Tools for NCSA Blue Waters 
  http://www.ncsa.illinois.edu/BlueWaters/ 
  Sustained Petaflop system 

  Based on Eclipse and PTP 
  Includes some related tools 

 Performance tools 
 Scalable debugger 
 Workflow tools (https://wiki.ncsa.uiuc.edu/

display/MRDPUB/MRD+Public+Space+Home
+Page) 

  Part of the enhanced computational environment 
described at:  
    http://www.ncsa.illinois.edu/BlueWaters/ece.html 
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NCSA HPC Workbench Coding & 
Analysis 

(CDT, PLDT, 
Photran) 

Scalable Debugger 

PTP  
Launching & 
Monitoring 

Performance 
Tuning 

(HPC toolkit,  
HPCS toolkit,  

RENCI, …) 

Workflow 
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Planned PTP Future Work 

 Scalability improvements 
  UI to support 1M processes 
  Optimized communication protocol 
  Very large application support 

 Resource Managers 
  More implementations of configurable resource managers 

 Synchronized project improvements 
  Conversion wizard 
  Resolving merge conflicts 

 Enhancements to the debugger 
  Stability enhancements 
  Transition to Scalable Communication Infrastructure (SCI) 
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Useful Eclipse Tools 

  Linux Tools (autotools, valgrind, Oprofile, Gprof) 
  http://eclipse.org/linuxtools 

  Python 
  http://pydev.org 

  Ruby 
  http://www.aptana.com/products/radrails 

  Perl 
  http://www.epic-ide.org 

  Git 
  http://www.eclipse.org/egit 

  VI bindings 
  Vrapper (open source) - http://vrapper.sourceforge.net 
  viPlugin (commercial) - http://www.viplugin.com 
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Online Information 

  Information about PTP 
 Main web site for downloads, documentation, etc. 

 http://eclipse.org/ptp 
 Developers’ (and users) wiki for designs, planning, 

meetings, etc. 
 http://wiki.eclipse.org/PTP 

  Articles and other documents 
 http://wiki.eclipse.org/PTP/articles 

  Information about Photran 
 Main web site for downloads, documentation, etc. 

 http://eclipse.org/photran 
  User’s manuals 

 http://wiki.eclipse.org/PTP/photran/documentation 
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Mailing Lists 

  PTP Mailing lists 
 Major announcements (new releases, etc.) - low volume 

 http://dev.eclipse.org/mailman/listinfo/ptp-announce 

  User discussion and queries - medium volume 
 http://dev.eclipse.org/mailman/listinfo/ptp-user 

 Developer discussions - high volume 
 http://dev.eclipse.org/mailman/listinfo/ptp-dev 

  Photran Mailing lists 
  User discussion and queries 

  http://dev.eclipse.org/mailman/listinfo/photran 

 Developer discussions – 
  http://dev.eclipse.org/mailman/listinfo/photran-dev 
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Getting Involved 

 See http://eclipse.org/ptp 
 Read the developer documentation on the wiki 
 Join the mailing lists 
 Attend the monthly developer meetings 

 Teleconference Monthly 
 Each second Tuesday, 1:00 pm ET 
 Details on the PTP wiki 

 Attend the montly user meetings 
 Teleconference Monthly 
 Each 4th Wednesday, 2:00 pm ET 

PTP will only succeed with your participation! 
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Thanks for attending 
We hope you found it useful	



PTP Tutorial Feedback 

 Please complete feedback form 
 Your feedback is valuable! 
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